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Overview”

Perspective Workflow™ is a business activity monitoring application that works behind the scenes
to help you stay on top of Perspective’s reported incidents, ongoing investigations and current

assignments. It monitors and auto-responds to critical, time-sensitive data, automatically notifying
the necessary personnel and guiding team members through the proper processes and protocols.

To get Perspective Workflow up and running, please follow the instructions provided throughout
this guide, in order of appearance.

Minimum System Requirements

Web Services Server

Available Disk SpaceJr
o 1GB

Processor Speed
o Minimum: 2 GHz

. Recommended: 3 GHz+

Memory

o Minimum: 1 GB

. Recommended: 2.5 GB+

Operating System

e Minimum: Windows Server® 2003 with SP 1

. Recommended: Windows Server 2003 with SP 2

.NET Framework
. Version 3.5SP 1

IIS (Internet Information Services)

o I1S 6.0, WSE 3.0

* This document is only applicable to organizations that have purchased Perspective Workflow,
an optional module for Perspective by PPM. If you are not certain that your Perspective system
includes Workflow, please contact Customer Service for verification.

f Depending on the size of your Perspective database, more disk space may be required.
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Database Setup

The Perspective Workflow database setup procedure depends on what version of Perspective
your organization is using and whether the Workflow setup is new or existing. Refer to the
procedure below to correctly setup your database.

New Workflow Setup — Perspective 4.0 and Greater

Follow this procedure if setting up Workflow for the first time and using Perspective 4.0 and
greater.

1. Open Microsoft® SQL Server® Management Studio.

2. Run the database views script PWFDataViews v2.0.sql against the Perspective database
being used with Perspective Workflow.
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ODBC Connection Setup

1.

Select Start > Administrative Tools > Data Sources (ODBC).

Note: Perspective Workflow uses the 32 bit ODBC manager regardless of whether you are
running Workflow on a 32 bit or 64 bit machine. On 64 bit machines, the 32 bit ODBC device
manager is typically located in the %winDrive/Windows/syswow64 directory and can be run
by executing ODBCAD32.exe.

Select the System DSN tab and click Add.

£10DBC Data Source Administrator

User SN System DSN l File DSN ] Drivers] Tracing] Connection Pooling] About ]

System Data Sources:

Mame | Diriver | Add..

Remove

Canfigure...

An ODBC System data source stores infarmation about how to connect ta
the indicated data provider. & System data source iz visible to all users
an thiz machine, including MT services.

0K | Cancel | Help

Select SQL Server and click Finish.

Create News Data Source E|

Select a diver for which you want bo set up & data source.

M ame | WA
ticrazaft QDBC for Oracle
icrosoft Parados Driver (*.db )
Microsoft Parados-Treiber (*.db )
Microsoft Test Driver [“.kat; " cev)
Microzoft Text-Treiber [*.tat; *.cav)
ticrozoft Visual FosPro Driver
ticrozaft Visual ForPro-Treiber

[ L e S R S A ]

1

3
|

| Firish E | Cancel
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Enter a Name and Description for the ODBC connection; select the name of the SQL
server that hosts your Perspective database; and click Next.

Create a Mew Data Source to SOL Server le

Thig wizard will help you create an ODBC data source that you can use to
connect ko SAL Server.

What name do you want o uze to refer to the data zource?

M arme: |Workflow ODEC Connectior|

Heaowe do pow want to describe the data source?

Description: |

Which SOL Server do you want to connect bo?

Server |BET.-’-\\5DLE:-:|:|reSS j

Finish | MHeut » Ri Cahcel Help

Choose the authentication mode you want to use for the ODBC connection (Windows
authentication or SQL authentication), and click Next.

Create a Mew Data Source to SOL Server E|

How should SAL Server verify the authenticity of the login ID?

f+ 3fith Yindows MT authentication using the network, login D

With SOL Server authentication uzing a login 1D and pazzword
entered by the user.

Ta change the netwark, library uzed to communicate with SOL Server,
click Chent Configuration.

Client Canfiguration...

v Connect to SEL Server to obtain default zettings for the
additional configuration optians.

< Back | MHeut » r_\l Cahcel Help
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6. Select the Change the default database to box and choose the name of your Perspective
database from the list below.

Create a Mew Data Source to SOL Server le

[v Change the default database to:

Ferspechy

e Sample] -

[ Attach database flename:

W Use ANS| guoted identifiers.
W Use &ANS| rlls, paddings and warmings.

r

¢ Back | Mest » &! Cancel Help

7. Ensure the Use ANSI quoted identifiers and Use ANSI nulls, paddings and warnings
boxes are selected, and click Next.

8. Click Finish.

X

Create a Mew Data Source to SOL Server

[ iChange the language of SOL Server system messages to

| I

[ Usze strang encryption for data

Iv Perform translation far character data

~ |z regional zettings when outputting currency, numbers, dates and
times.

[~ Save long running queries to the log file:

Laong quern time [millizeconds):

[ Log ODBC driver statistics to the log file:

| _Browse. |
< Back | Finizh &l Cancel | Help ‘
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9.

Click Test Data Source.

ODBC Microsoft SOL Server Setup

& new ODBC data zource will be created with the following

configuration:

3

Microgaft SAL Server ODBC Driver Werzion 03.36.3359

Data Source Mame: Workfow ODEC Connection
[Drata Source Description:

Server, BETAMNSOLE spress

D atabaze: Perspective_Sample

Language: [Default)

Tranzlate Character D ata: Yes

Log Long Running Queries: Mo

Log Drriver Statistics: Mo

|lze Integrated Security: Yes

Ilze Regional Settings: Mo

Prepared Statements Option: Drop temporary procedures on
digconnect

Ize Failowver Server: Mo

IJze AMS| Quoted |dentifiers: ez

ze ARSI Mull, Paddings and "W armings: es
[rata Encryption: Mo

Test Data Source... C% (] | Cancel |

10. When the data source connectivity test is complete, click OK.

SOL Server ODBC Data Source Test

Test Results

X

Microsaft SCL Server ODBC Driver Yersion 03.86.3959
Running connectivity tests. .

Alternpting connection

Connection established

Wernfving ophion settings

Digconnecting from server

TESTS COMFLETED SUCCESSFULLY!
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Perspective Workflow Installation

1. Double-click the PW_Setup_V82d.msi file located inside the Installation Files v1.0 folder;
then click Run.

Open File - Security Warning |
The publisher could not be verified. Are you sure you want to
run this software?
Mame: ...orkflow\Installation Files v1.0\PW_Setup_V78.msi
Publisher: Unknown Publisher
Type: Windows Installer Package
From: C:\Perspective Workflow\Installation Files w1.0\PW...

Run | Cancel I

¥ Always ask before opening this file

This file does not have a valid digital signature that verfies its
publisher. *ou should only run software from publishers you trust.
How can | decide what software to run?

2. Click Next.

i Perspective Workflow Setup o ]

Welcome to the Perspective

7 Workflow Installation Wizard

It iz strangly recommendead that you exit all Windows programs
before running this setup program.

Click Cancel to quit the setup program, then cloge any programs
you have running. Click Mest ta continue the installation.

WARMIMG: This program is protected by copuright law and
international treaties.

Unauthorized reproduction or digtribution of thiz program, or any
portion of it, may result in severe civil and criminal penalties, and
will be prozecuted to the maximum extent possible under law.

< Back Cancel




Perspective Workflow Installation Guide

3. Select the | accept the license agreement radio button, and click Next.

i'.fa Perspective Workflow Setup

License Agreement

Y'ou must agree with the licenze agreement below to proceesd.

Please zsee PPH 2000 Inc,. Software Licence Agreement for
Terms & Conditions of use.

% | accept the icense agreement

| do not accept the licenze agreement

YWize [nstallabion ‘Wizard®

Beszet < Back Hest > Cancel
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4. Read the installation information, and click Next to begin the install.

i'-‘% Perspective Workflow Setup

Readme Information

The following information describes thiz installation.

PPM 2000 Inc. Perspective Workflow V1.3 (build 8.2d) HNHotes
August 4, 2013

You must have ODBC installed on all computers that will use
Perspective Workflow. You must alsco have a unigque ODBC
source for esach application that you wish to create inside
Perspective Workflow.

Before you can access PPM 2000 Inc. Perspective databases
within Perspective Workflow, vou must first create a unigque
System Data source name (DSH) pointing to your PPM 2000
Inc. Perspective SQLServer Database.

Wize Inztallation Wizard®

< Back | MHext » I Cancel

5.  Enter your user information, and click Next.

i'.‘w!;'- Perspective Workflow Setup

User Information

Enter the following information to personalize wour installation.

Full Mame:

Organization: FF 2000 Inc.

The zettings far this application can be installed for the current user or for all users that
zhare this computer. v'ou must have administrator rights to install the settings for all
uzers. Install thiz application for;

& apyone who uzes this computer

" Only for me [Testing]

Wize Inztallation YWizard®

< Back | Mest » I Cancel
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6. The default install destination will be displayed. (If a different location is preferred, use the
Browse button to navigate to the chosen location.) Click Next.

ii_il Perspective Workflow Setup

Destination Folder

Select a folder where the application will be installed.

The “Wize Installation “fizard will inztall the files for Perspective ‘WWarkfiow in the fallowing
folder.

To inztall into a different folder, click the Browse button, and zelect another folder.

You can chooze not to install Perspective Workflow by clicking Cancel to exit the YWis....

Dreztination Folder
’7E:"-.F'rn:-gram FilezhPPM 2000 InchPerspective Yok o, Browse |

YWize [nstallation Wizard®

Cancel |

< Back

10
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11

Accept the default settings for all components by clicking Next.

Note: Remote Perspective Workflow clients must be individually licensed in order to run the
Workflow application. If you install one or more remote Perspective Workflow clients, you
must only install the core and client components on each remote client. You will not need to
specify the location of the Workflow database during the installation process; the first time
that a remote client is executed, the user will receive a browse button allowing them to

locate the Workflow database.

il Perspective Workflow Setup

Select Features

Fleaze select which features you would ke ta ingtall

Core Components

Server Components

Client Components

Feature Description:

Select thiz feature if the servers and databaze
will be installed on this computer. Do not zelect
thiz feature if the database and zervers are
lozated on anather computer on the netwark.

T hiz feature will be installed on the local hard
drive

T hiz feature requirez 175MB on pour hard
drive.

Browse |

Wize [natallation ‘wWizard®

Dizk Cost Beset

< Back | Hent » I Cancel |
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8.  Click Next to begin the installation.

i'a‘!:“ Perspective Workflow Setup

Ready to Install the Application

Click Mest to begin installation.

Click the Back button to reenter the installation infarmation or click Cancel to exit
the wizard.

Wize [natallation ‘wizard®

< Back | M et > I Cancel

Note: The service needs to run using an account that has local admin rights to the server
where workflow is installed.

12
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9. If prompted to confirm the installation, click Yes.

Program name:
Publisher:

File origin:

j Show details

{:_!l User Account Control

| T | Do you want to allow the following program from an unknown
"%/ publisher to make changes to this computer?

C:VPW _Setup_Vva2d'PW _Setup Va2d.msi
Unknown
Downloaded from the Internet

Yes Mo

Change when these notifications appear

13
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i'x'!:ll‘ Perspective Workflow Setup

Updating System

The features you selected are currently being installed.

|lpdating component reqistration

H

Wwiize Inztallation Wizard®

Cancel

10. Click Finish once the installation is complete.

iikE" Perspective Workflow Setup =10 x|

Perspective Workflow has been
7 successfully installed.

Click the Finizh button bo exit thiz installation,

< Back | Finizh I Cancel

14
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11. Open Windows Explorer.
12. Navigate to the destination folder.
Note: The default location is C:\Program Files\PPM 2000 Inc\PerspectiveWorkflow\
13. Select the bin folder.
14. For each of the following executables (ks_admin.exe, ks_event.exe, ks_mon.exe,

ks_serv.exe), right-click, select Properties, the Compatibility tab, Change settings for all
users button, and finally, select Run this program as an administrator. Click OK. Click OK.

15
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IM Installation

There are two IM installations: IM32 (for 32 bit machines), and IM64 (for 64 bit machines). As IM
is optional, only install it if you will use it.

The IM Accounts option enables you to configure and maintain the Instant Message accounts
from which you will send notifications. Note that you can configure multiple IM accounts using
multiple IM methods, such as Windows Live Messenger, Google Talk, and ICQ, so that you can
receive IM alerts via one method while at work and via a different method while at home.

It is suggested that prior to setting up this account that you send IM “invitations” to all the
recipients. Note that some IM providers (e.g., Windows Live Messenger) requires an IM recipient
to “accept” invitations from an account before the messages can be successfully delivered,
whereas other IM providers (e.g., ICQ) require “invitations” but do not require recipient
acceptance.

1. Double-click the IM.msi or IM64.msi (32 bit or 64 bit) file located inside the Installation
Files v1.0 folder; then click Run.

Windows Installer

_o[d| Preparing to instal...

| Please wait whils Windows corfigures IM SDK

Gathering required information....

I 0 | Cencel |

Extracting Files EI

Extracting File: Minstall exe
To Directory: chd 75937 0d310c0fbatldh5702 1de 359

16
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Licensing & Server Login Information

4.

17

Open the Perspective Workflow Administrator. The application can generally be accessed
through Start > Programs > Perspective Workflow > Administrator.

In the logon window, enter your administrator User Name and Password, then click OK.
(The default User Name is Admin and the default Password is master.)

B Perspective Workflow Administrator “

Uzer Marme: |.-’-'u:|min

Paszword: |’1

Cancel |

Under the Help menu, select About Perspective Workflow Administrator.

File View Help

JJ% Print | ¢ Contents
PPM 2000 Inc. on the Web

Activity

About Perspective Workflow Administrator...

= gia Actity
I e I S mruer Stahus h

Server Status

Click the License button.

B3 About Perspective Workflow Event Manager “

Perzpective Workflow Event Manager

A PETSPEEH:I"E' Wersion 2000.8.2f

l“"\‘" w kf I Thiz application iz licenzed to:
pid ™ MOT FOR RESALE PRM2000
OrKriow

PP 2000 Inc Perspective ‘Woarkflaw 0K |
Copyright [c] 1998-2013, Vineyardsoft Corparation. All Rights Reserved,

“wharning: Thiz zoftware praduct iz protected by copyright law and
interational treaties.

Bazic Scrpting provided by Cepress Software, Inc. [c] 2013

System Infa... |
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5.  Enter the license information provided to you by PPM 2000 and click OK, then OK again.

License Dwner: 0T FOR RESALE PPM2000

Licenze Expiration Date: |2E|1 B0717

License Code: |4DE243D 2914242954
Licenze Type: IENTEF!F'FHSE-WEEEASTEH ;I

Licensed Server Mame: I

Licensed DB Connections: I
ok | Cancel |

6. Click the Server Login Information button on the toolbar.

|| Eile view Help

”% Print | @ Server Login Information

Activity
Comective Action
Hardware Setup

Software Setup

Adrminiztration Folders
E ............ ﬁ '{"th I lDI SEW’E[

7.  Enter your administrator User Name and Password, then click OK. (The default User Name
is Admin and the default Password is master.)

Note: If the fields are pre-populated, delete the values and re-enter your login information.

User Mame: |!-’-‘«dmin

Password: | ******

Cancel |

8. Close the Perspective Workflow Administrator; then, start the Perspective Workflow service
in Computer Management.

18
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Email Setup

1.

3.

19

Open the Perspective Workflow Administrator. The application can generally be accessed
through Start > Programs > Perspective Workflow > Administrator.

In the logon window, enter your administrator User Name and Password, then click OK.
(The default User Name is Admin and the default Password is master.)

D3 Perspective Workflow Administrator “

Uszer Narme: |f-‘-.dmin

Password: | ***** q

Cancel |

Expand the Software Setup node, click Email Accounts and click the New Email Account
button in the top-left corner of the window.

Pe
File Edit View Help

'Tf], New Email Account | % Print | X Delete | ’;E Perform Email Test

Activity

Corrective Action
Hardware Setup ] on
Software Setup Achivity | D | Descriptian | Email Type | Download Email |
ﬂ Server Status
Current User Logine
Comective Action
Hardware Setup

Adrniristration Folders

Fax Accounts
Fax Cover Pages

2 Holiday Schedule
Q IM Accounts

& Paging Services
g Twitter Accounts
g Wwebcast Locations
[ L_q]_ Uzer Aocess

Select INTERNET for the Email Type field; populate the Email Account Description,
Outgoing Mail (SMTP) Server Name and SMTP From Name fields (the SMTP From
Name field must be populated with a valid email address); ensure that the Active box is
checked; and click Save and Close.

Note: You must create a separate Perspective Workflow email account for each email
address that you want email naotifications to be delivered from. For instance, if you would like
employees in different departments to receive email notifications from different email
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5.

accounts, you must create a Perspective Workflow email account for each department.
(Keep in mind that each event can only use one email account to send notifications from.)

=l Perspective Workflow - Email Accounts
Eile Edit Help
n Save and Close H Save and New }( Delete | 4 Previous = 9 Next =

Ermail Account Description: Woarkflow Email

General T Dial-Up Metworking T Email Responze Systerm Options [Incoming] T Higtory 1

Internal 10 number: |2
Email Tope: [IMTERMET - Character Set: |ascii j

Email Account Description: |W'.;.[k[|.;.w E mnail

Login Mame, Mailbox ar Profile M anme: |

Pazzword: |

Postoffice [Exchange, Motes or Wik onlu]: |

v Active
SMTP/POP Internet Email Information:

Outgaoing mail [SMTP] server name: |mai|. company.com

SMTF From Mame [required for INTERMETY: |Ferspective wharkfow <workAow@ppm2000. conms
St TP Port [optional]: |

Incoring mail (POP] server name: |mai|._l.JDurISF'.net

FOF Part [optional): |

Motes:

Close the Perspective Workflow Administrator.

IM Setup

1.

Open the Perspective Workflow Administrator. The application can generally be accessed
through Start > Programs > Perspective Workflow > Administrator.

In the logon window, enter your administrator User Name and Password, then click OK.
(The default User Name is Admin and the default Password is master.)

20
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3. Expand the Software Setup node, click IM Accounts.

Eile Edit Wiew Help

5 New IM Account | &5 Print | ¥ Delete | ¥4l Perform IM Test

| ! Adminiztration Folders

=t ﬁ Activity I I} I Drescription I 14 I
E Server Statuz
-8 Current User Logine
0 Comective diction
Hardware Setup
Software Setup
e 2 Ernail Azcourts
il Fam Accounts
Fax Cover Pages
Haliday Schedule
Q I nts
& Paging Services
| Twitter Accounts
g Webcast Locations
[]'_! User dccess

Activity
Corective dction
Hardware Setup

Software Setup

4. Service Provider: Select from Windows Live Messenger, Google Talk, Yahoo! Messenger,
and ICQ.

Account Description: A description of the account that will be used for sending IM
notifications.

Username: The user name for this IM account. Note that different IM methods (such as
Windows Live Messenger and ICQ) require different types of login information. Typically,
Windows Live Messenger uses an email address whereas ICQ uses a unique numeric
identifier. Please refer to the documentation/help text for your preferred IM provider for

details.
Password: The password of this IM account.

Active: Whether this account is currently available for sending IM alerts (you can configure
an account without enabling it for immediate use)

Note: Each IM alert message may not exceed 1,500 characters (including spaces) in length.

21
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File Edit Help

[ save and Close i Save and New | > Delete | A Previous ~ W Next -

Instant Meszzage Service Provider:

General | History

Internal 1D number: I

Instant Message Service Provider: I\-\-"indows Live Messenger ;I

Instant Message Account D escription: I\-\-"indows Live

Username: Iacmecolp@live.cum

Pazzword: Ixxxw«i

v Active

22
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Perspective Workflow Event Pak Installation

1. Open the Perspective Workflow Event Manager. The application can generally be accessed
through Start > Programs > Perspective Workflow > Event Manager.

2. Inthe logon window, enter your administrator User Name and Password, then click OK.
(The default User Name is Admin and the default Password is master.)

Uszer Narne: |Admin

Pazswond: | ***** g

Cancel |

3. Under the File menu, select Event Pak then click Install.

[ Eile view Help

JJ Vendor Identification...
Exit Builder...

< ubscriber

Install...

License Generator...

4.  Browse to the location of the PerspectiveWorkflowEventPak v2.0.kse file (included in the
Event Pak folder); then, click Open.

@ v M .l <« New.. » BaseEvent Pakw... v Search Base Event Pak v2.0 2

Organize = Mew folder B== m @

~ MName Date modified Type

4 ﬁ Favorites
B Desktop E PerspectiveWorkflowBaseEvenPak v2.0.kse  2013-08-26 1:33 PM  EBSAlerts
j Downloads
“El Recent places

| Documents

4 M This PC
[> j Desktop

& (Bl Nariman . i =

File name: | PerspectiveWorkflowBaseEvenPak v| |EventPaks (*kse)

| Open |v|| Cancel

23
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5. Click Install.

EventPak Dezcription:

Cormpany:

Sales Contact Mame:
Sales Phone Nurmber:
Sales Email Address:
Sales Website Address:
EwentPak Yersion:

EventPak Release Date:

Installation Motes:

£ > ||||||

The following Application(g] will be installed into the Database

- Application

Destination Folder/Application [Click. for dropdown list]

Standard Event Pal - &

Install as neww application into folder-> Application Events

| Standard Event Pak - Admin

Install as new application inta folder-> Application Events

Standard Event Pak - Azsignments -

Inztall az new application inta folder-> Application Events

Standard Event Pak - Caszes

Install as neww application inta folder-> Application Events

Standard Event Pak - elncidents

Inztall as new application into folder-» Application Events

-

Inztal |

6. When the Finished message appears at the bottom of the window, click Close.

Cancel |

x

Reloading, pleaze wait...

7. Select one of the Standard Event Paks under Application Events.

8. Click the Properties button to bring up the database connection window.

24
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10.

11.

25

Delete all connections that currently exist by selecting them, clicking Edit Connection, and

Delete.

i@

| File View Help

JJ’L‘_:L News Application | h New Folder | % Print

Application E

' Event Management Folders

@ Application Events
v 88 Compary Narme

\’J Standard Event Pak -
| Standard Event Pak -
Standard Event Pak -
4| Standard Event Patk -
@ Standard Event Pak -
4| Standard Event Pak -
| Standard Event Pak -
| Standard Event Pak -

Activities

Adrmin

Azzignments - General
Cases

elncidents

Incidents

Items

Organizations

Personz
Yehicles

Standard Event Pak -
Standard Event Pak -
-HE Subscribers

i i

With Perspective Connection selected in the Connection to Use For Database Access
field, click the Edit Connection button.

) |

5 Perspective Workflow - Standard Event Pak - Activities Properties

Description: IStandard Ewent Pak - Activities

Connection to Use For D atabase Access:

LI Edit Connection... |
Mew Connection... |

Cancel |

In the ODBC Data Source Name (DSN) field, select the ODBC connection that you created
in the ODBC Connection Setup phase of this installation process; click Save and Close;
and then click OK.

Note: If SQL authentication was used for the ODBC connection, you must also enter your
SQL credentials in the Username and Password fields. These will be the same credentials
that Perspective uses to connect to the database, not the username and password used to
get into Perspective.
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Eile Edit Help

[ save and Close | 3 Delete

Conrnection Description:

General | History

Internal ID number; |?4

Connection Description: |Elandard Event Pak - Activities

ODBC Data Source Name [DSM): |

Usermname:

Pazsword:
Date Separation Character; Uze Coordinated Univerzal Time [UTC) for Date/Times |l
Long Tablename LEFT Character: Lirk Al ain prefix (0ptional]: l—
Long Tablename RIGHT Character: LinkAlain suffis [0ptional) l—
Column Alias Character:
[v Retieve Database Owner with objects if available.

[~ Remove parentheses from Link/Aloing

Script AP Mame:

Script AP Usermame:

Script 4Pl Paszword:
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Subscriber Configuration

In Perspective Workflow, individuals who receive email notifications when events are triggered
are known as "subscribers." Each event must have one or more subscribers associated with it,
but before you can choose subscribers for each of your events, you must either manually create
subscriber records within Perspective Workflow or link user records in your Perspective database
to Perspective Workflow's subscriber list.

Note: Subscriber linking is dynamic; in other words, updates to your Perspective user records will
automatically be reflected in your Perspective Workflow subscriber list.

For more information on subscriber configuration, please refer to the Subscriber Maintenance
section of the Perspective Workflow User’'s Guide.

Manually Creating a Subscriber

1. In Perspective Workflow Event Manager, expand the Subscribers node and select Users.

@'

|| Eile View Help

Hh New Group | Bh New Folder | % Print

kf' Ewvent Management Faolders
EQ Application Events Description
d

@ Standard Event Pak - Activities

; \’J Standard Event Pak - Admin

\"J Standard Event Pak: - Azsignments - Gene
."J Standard Event Pak - Cazes

; \"J Standard Event Fak - elncidents

."J Standard Event Pak - ltems

\’J Standard Event Fak - Organizations

: \"J Standard Event Pak. - Perzons

.,J Standard Event Pak - Wehicles

=-#8 Subscribers

2. Click the New Group button in the top-left corner of the window.
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3. Enter a Description for your group; then click OK.

Descriptior: b anagement

Subscriber Linking. . Cancel |

4.  Select your new group under the Users node, and click the New User button.

| Eile View Help

”ﬁ Mew Group | #7) New Folder | &h Print

lf Event Management Folders
EIQ Application Events
& Company Mame
| Standard Event Pak - Activities
4| Standard Event Pak - Admin
4| Standard Event Pak. - Azzsignments - Genel
4| Standard Event Pak - Cases
4| Standard Event Pak - elncidents
4| Standard Event Pak - Incidents
4| Standard Event Pk - Items
4| Standard Event Pak, - Organizations
| Standard Event Pak - Persans
.J Standard Event Pak - Wehicles
=8 Subscribers
ﬂ Computers
-5 | :

SOBEEeBEEe
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5. Complete the Last Name and First Name fields, and check the Active box. (The Full
Name field will automatically populate.)

& Perspective Workflow - Subscribers\Users\Managment H
File Edit Help
& save and Close is save and New | ¢ Delete

Subscriber Mame:

Description ]Cop_l,l] Email] Fax] F'age] WebCast] Inztant Message] Subscriptions]

Internal 1D Aumber:

Last Mame: |5 Trith

First Mame: |5 ara.Jane

Full Mame: |Emith, Sara Jane
Job Title:

Company Mame;

- |

- |

Phone Mumber: |
IP Address: |

Cormputer Mame: |

User Laakup ey [SMITHS

[ Active
Histary:

Itemn created by

Itern created or

Item last changed by

Itern lazt changed an

‘ Mest »» | Cancel Help

6. Select the Email tab, specify the subscriber’s primary email address in Email Address 1
and, if applicable, enter their secondary email address in Email Address 2.

7. Indicate which email address (1 or 2) should be used on various days of the week and times
of day to notify the subscriber of an event's occurrence. To indicate that both addresses
should be used in a given time slot, enter an asterisk (*), or you may leave the slot blank to
indicate that neither email address should be used. Alternatively, you can click the Use
Address 1 for All, Use Address 2 for All, or Use Both for All buttons to quickly apply
settings to all time slots.
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8.

&

Perspective Workflow - Subscribers\Users\Managment

File Edit Help

[ save and Close ] Save and New | ¥ Delete | FS

I

=1

=
T

D escriptionl Copy

Subszcriber M ame:

Email |Fa:-:| F'agel WebCastI Instant Messagel Subscriptionsl

Email Address1: Isaraiane.smith@acme.com

Ermnail &ddress2: Ilsaraiane.smilh@acme.com

Please zelect which Emaill Address to use at the specified time:

1=Email &ddrezs 1, 2=Email Address 2, * = Both, Space Bar for None

Segment

Sunday

Monday Tuesday

Wednesday

Thursday

Friday

S ahurday

» 12:00 AM

2

2 2

2

2

2

12:30 4M

1:00 &AM

1:30AM

2:00 &M

230 .AM

3:00 &M

3:30AM

4:00 4M

4:30 AM

5:00 &M

5:30AM

B:00 &M

AR RR ) R DR R ) )

P | s [P | P | P P | P o [P P | o
P | Pl [ Pl | P | P | Bl [ Pl | P | P | Bl [ P P

Podn | Pl [ Pl | P2 | Podr | Bl | Pl | P | e | Bl | Pl | 0|

P | P2 [ P P | P2 | Pl [ P P | | Pl | P | P

AR RN R RO R R )

AR RR ) R DR R ) )

Restore Defaults |

Use Address far Al |

Use Address2 for Al |

Use Both for Al

¢ Back |

Mest »» |

Cancel |

Help

IM Setup for Subscriber: Select the Instant Message tab, select the Instant Message

Service Provider, and finally, select the IM Username of the subscriber (the person who will
be receiving the IM notifications).
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& Perspective Workflow - Subscribers\Users\Managment E
Eile Edit Help
[E save and Close i Save and New | ¥ Delete | 4 Previous + ¥ Next -

Subszcriber Name:

Descriptionl Cop_l,ll Emaill Fa:-:l F'agel webCast Instant Message Subscriptionsl

Instart Messags Service Provider 1: || ;I

Instant Message Usemame 1: Isalaiane. smith

Inztant Message Service Provider 2: | ;I

Inztant Message Usemame 2 |saraiane. smith

Please select which Mame to use at the specified time:

1=Mamel, 2=Mame2, * = Both, Space Bar for Mone

Segment| Sunday tonday Tuesday | ‘Wednesday | Thursday Friday Saturday |~
12:00 Ak 2 2 2 2 2
12:30 &M

1:00 AM
1:30 &AM
200 &AM
2:30 AM
3:00 &AM
3:30 &AM
4:00 AM
4:30 &AM

-
[o%)
%)

P | P | B | B [P | P | B R | P
PO P B B [P P R R P
SRS LSRR Y S RN N
P | P | B | B [P P | 2 P [ P2
P | P | B | B [P | P | B R | P
SRR SA RO LS DR NN
SRS LSRR Y S RN N

Restore Defaults | Use Namel for Al | Use Name2 for &l | Use Both for &1 |

<+ Back | Next »» | Cancel | Help |

9. Click Save and Close.

10. Continue to apply these steps to manually create additional subscribers as needed.
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Linking a Subscriber Group

1. Inthe Perspective Workflow Event Manager, select one of the default groups under
Subscribers > Users (i.e., Perspective Users, Perspective Supervisors or Perspective
Users). Then, click the Properties button at the top of the window.

rf!ﬂ Perspective Workflow Event Manager
|| Fie Edit view Help

J_I'EI,”EWUS’EV | &b Print | > Delete | B4 properties
EvEni Subscribers

Subscrbers

EI@ Application Events
o8| Standard Event Pak - Activities
i/ Standard Event Pak - Admin
| Standard Event Pak - Azzignments -
i/ Standard Event Pak - Cases
i/ Standard Event Pak - elncidents
\’J Standard Event Pak - ltemns
| Standard Event Pak - Qrganizations
i/ Standard Event Pak - Persans
\3] Standard Event Pak - Wehicles
=-H#¢ Subscribers

ﬁ Computers

-8 Users

----- & Perspective Investigators

Ll Perzpective Supervisors

2. Click the Subscriber Linking button.

3 Perspective Workflow - Perspective Users Properties - U

Description: IPerspective Users

0K | Subscriber Linking... I Cancel |
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3.  Click the Select Query button.

&5 Perspective Users Subscriber Linking = B

Subscribers of content are stored in the database. Optionally. you may create a link to subscribers that exist outzside of
the databaze. You must first define a query that retrieves the subscriber information. ' au must then must specify
which fields from the query equate to fields inside the subszcriber databaze. Once the subzcribers are linked, the
praduct will uze the linked infarmatian in order ta perform content delivery.

Query to use as subscriber content:

Subscriber Linking Field Definition
Subscriber Field Linked to Database Field
¥ | Subscriber Name =
Last Mame =
Firgt Name =
Title =
Company Mame =
Phone Mumber
Computer Mame =
IP &ddress =
Email Address 1 =
Email Address 2 =
Pager Terminal Murmber 1 =
Pager Terminal Mumber 2 =
Pager PIMN Mumber 1 =
Pager PIN Murnber 2 =
Far Murnber 1 =
Fax Murnber 2 =
“Webcast Mame 1 =
“Webcast Name 2 =
Copy Location 1 =
Copy Location 2 =

Ok | Remove Subscriber Link... | Cancel |

4. Select the Standard Event Pak - Admin application from the list by clicking on the arrow to
the left of the name; then click the Select button.

£y Perspective Workflow - Select Another Application = B
Select Another Application
Application

Standard Event Pak - Activities
Standard Event Pal: - &
Standard Evert Pak - Azsignments - General
Standard Event Pak - Cazes

Standard Evert Pak - elncidents

Standard Event Pak - lbems

Standard Event Pak - Organizations
Standard Event Pak - Persons

Standard Event Pak - Wehicles

Select | Caricel |

33




Perspective Workflow Installation Guide

5. Select Admin — All Users with Primary Email.

6. Then, click the Select button.

Application: Standard Event Pak - Admin

Select Another Application

Queries Awvailable For This Application

(uery Dezcription

Aydmin - All Curent Logged On Users

Adriiin - All Uzers

Admir - Al Users FRole +'
) ith Primary E mail
- Al Ugers wWorkgroup =

- Syztem Adminiztrator Login

MNew Query... |
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7. Inthe Linked to Database Field column on the right, select only the values shown in the
following screenshot and click OK; then, click OK again.

Note: This will link only to each subscriber’s primary email address in Perspective (the emalil
address that appears in the subscriber’s Person record with the Primary box checked.)

i Perspective Users Subscriber Linking = =

Subscribers of content are stored in the database. Optionally, pou may create a link to subscribers that exist outside of
the databaze. r'ou must first define a query that retrieves the subscriber information. vou must then must specify
which fields from the guery equate to fields inzide the subsorber databasze. Once the subscribers are linked, the
product will use the linked infarmation in order ta perform content deliveny.

Query to use as zubscriber content:

Adrir - All U zers Select Query... |

Subsgcriber Linking Field Definition

Subscriber Field Linked to D atabase Field
Subscriber Name =

Last Mame = | LastMame
Firgt Mame = | FirgtMame
Title =

Compary Mame =

Phone Mumber =

Caornputer Marme =

IP Address =

Email Address 1 = | Emailtddress
Email Address 2 = | Emailtddress

Pager Terminal Mumber 1 =
Pager Terminal Mumber 2 =
Pager PIM Humber 1 =
Pager PIN Humber 2 =
P | Fax Mumber 1 = -
Fax Mumber 2 =
wiehcazt Mame 1 =
wiehcazt Mame 2 =
Copy Location 1 =
Copy Location 2 =

ak. | Remove Subzcrber Link... Cahicel |
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Application Creation

Before using any of the events in your Perspective Workflow Event Pak, you must complete the

following steps:

1. Select Application Events.

|| Eile View Help
JJ-’EJ, New Application | #7) New Folder | & Print

=

- Botivibies
."J Standard Ewvent Pak - Admin
."J Standard Event Pak - Aszignments - Gene
.J Standard Event Pak - Cazes
| Standard Event Pak - elncidents
| Standard Event Pak - ltems
."J Standard Event Pak - Organizations
."J Standard Event Pak - Perzonz
-Wehicles

Em Izers

---- HE Management

------ # Perspective U sers

2. Click New Application.

3. A pop-up will appear telling you to name the application. Select the ODCB connection that

was created earlier.
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New Application |Company Mame

Connection to Uze For Databaze Access:

4. Click OK.

37
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Cancel |




Perspective Workflow Installation Guide

Event Configuration

Before using any of the events in your Perspective Workflow Event Pak, you must complete the
following steps:

. Specify the filter values that each event’'s queries will use (if applicable).

. Run each event once using the Schedule This Now option.

. Set each event to "Active" status.

. Select the email account that each event'’s alert messages will be sent from.

. Ensure that each event has at least one subscriber with the Email box checked.
o Enter a schedule for each event.

For more information on configuring events, including designing events of your own, please refer
to the Event Designing section of the Perspective Workflow User’s Guide.

1. Inthe Perspective Workflow Event Manager, expand the Standard Event Pak - Incidents
node and select Events.

Eile Edit View Help

15 New Event | & print | ¥ Delete | . Schedule This Now | # Test This Now

Eg Event kanagement Folders

Events

= @ Application Events Description Prricirity
; Compary Name P | * Incident - Closed Incidents - Set 1 pear expiry 5
Standard Event Pak - Activities * |mcident - List - Access Level % 5

3 Standard Event Pak - Admin * |nczident - List - Closed Last Manth 5

QJ Standard Evert Pak - Assignments - Genel * Incident - List - Created in the Last W' Days 5

Q_J Standard Event Pak - Cases * |ncident - List - Created Last bManth 5
Standard Event Pak - elncidents # |mcident - List - Created YTD 5

Standard Event Pak - Incidents * Incident - List - Disposition 5

3 Query Definitions # Incident - List - Due in %' Days 5

* |ncident - List - Flag of "' i}

epoart D efinitions * Incident - List - Incidents Lagt Manth By Site "' 5

:] Scheduled Reports * |ncident - List - Investigation Clozed Last Month 5

L Basic Seripts * Incident - List - Mo Activity in ‘%' Dayps 5
E]\’J Standard Evert Pak - ltems * Incident - List - Mo Assignments [}
[]@J Standard Event Pak - Drganizations * |ncident - List - No Ireestigator Assigned 5
[]\’J Standard Event Pak - Persons * Incident - List - Wot Access Level of ' - Status " 5
[]""*31 Standard Event Pak - Vehicles * Incident - List - Open far More than ' Days 5
Elﬁ Subscribers * Incident - List - Dwer Rale of %' - Statuz %" 5
‘ﬁ Camputers * Incident - List - Site of ' 'w/ith Open Status ]
-8 Users * Incident - List - Status W 5

2. Double-click an event in the list on the right that meets your requirements (consult the
Workflow Event Paks document).
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e For this example, we are going to use Incident — Single — Incident Class ‘x’.

= Perspective Workflow - Application Events\Standard Event Pak - Incidents\Events “

File Edit Help

[ save and Close i Save and New | W Delete | 4 Previous ~ 9 Mext -

Event Description: Incident - Single - Class of W'

Description |Queries| Heportsl FiIesI Eopyl EmaiII Faxl Pagel WebEastl IMI Actionsl Subscribers| Schedule| Track

Internal 1D number: |321 3
Event Description: |Incident - Single - Class af '

Laokup Key [Optional): I

Pricrity [0=Highest]: |5 - l

v Active

I~ FRepeat naotification for tiggered items.

¥ Keep only last checked record in Monitor.

Higtony:
Itemn created by: IPerspective ‘workflow Event Manag
Item created an: |2D1 4-06-30 11:20:48 &M
Itern last changed by |Perspective wiorkflow Event Manag
Itern lazt changed ar: |2D1 4-06-30 11:20:48 &M
Motes:

<< Back | Mest 3> Cancel Help

3.  Double-click the Event to open it.

4,  Click the Queries tab.
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) Perspective Workflow - Application Events\Standard Event Pak - Incidents\Events
File Edit Help

[ save and Close g Save and New | W Delete | 4 Previous ~ W Next ~

Event Description:  Incident - Single - Class of '

|F|ep0rts| FiIesI Eop_l,ll EmaiII Faxl F'agel WebEastI IMI Actionsl Subscribers Schedulel Track

Description

Gueries Selected For Content

I Application I Guery Description I

Add Query... | b | Standard Event Pak - | Ingident - Class ' |

[~ Use Script instead of Querny Seript: I Select Script... |
<-Remove Query | <<-Remove &l Queries |

Ewent Trigger Parameters

Question Anzwer
‘What Class value would you like to filter by?
How far back would you like to search?

v

<¢ Back | Mext »» | Cancel Help

5. Make a note of the query it is using.
6. Close the window.

7.  Highlight the Event and CTRL + C.

-8 Users * Incident - List - Status W'

* Incident - List - Workgroup "% - Status "

* Incident - Marmalize Access Level to 1

* Incident - Single - Access Level

* Incident - Single - Blank Outcome with Status Closed

* Incident - Single - Buziness Unit Level 1 of '

* Incident - Single - Buzingss Unit Level 1 of ', Lewvel 2"

* Incident - Single - Business Unit Level 1 of W', Level 2 ", Level 3
* [ncident - Single - Business Unit Level 1 of W', Lewel 2 ™", Level 3

Sl o [on [ on [en | on e | on | on | on

e -

* Incident - Single - Class of '+, Categaony "

* Incident - Single - Class of W', Category ™", Subcategory &'
* Incident - Single - Due in ' Dapz

* Incident - Single - Flag of "'

* Incident - Single - Follow-up Reguired in ‘s’ Daps

* Incident - Single - Inwvolved Perzon with Flag of '

* Incident - Single - Mew Incident

* Incident - Single - New Investigation by site '

* Incident - Single - Mo Activity in ‘%' Days

5
]
5
b
5
5
5
5
9

8. Go to the application that you created earlier.

9. Expand it and click Events.
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File Edit View Help

5 New Event | & print | ¥ Delete | # Schedule This Now |

Events

v& Event Management Folders
EI& .ﬁgplication Ewvents
E|.J Compary Mame
- Query Definitions

-| =) Report Definitions

¢ | Scheduled Reports

-f}i Basic Scripts

I:I'J Standard Event Pak - Activities

I:I--.J Standard Event Pak. - Admin

[]—-.] Standard Event Pak - Assignments - Genel
£

b

].J Standard Event Pak - Cases
].J Standard Event Pak - elncidents
I':'I.J Standard Event Pak - Incidents

10. Make the Description window active by clicking inside of it.

11. Type CTRL + V to move the Event.

| Eile Edit View Help

JJ-‘E:L New Event | & print | ¥ Delete | # Schedule This Now | 3 Test This Now

E Event Management Folders
H--Q Application Events I Drescription I Priorityl

E‘.J Company Name B E Incident - Single - Class of '’ | 3

3 Query Definitions

E Events

Fieport Definitions
Scheduled Reports
wig Basic Scripts
I:I--'J Standard Event Pak - Activities
B3] Standard Event Pak - Admin
[]--.] Standard Event Pak - Azsignments - Genel
£
b

:I.J Standard Event Pak - Cases
].J Standard Event Pak - elncidents
=] .J Standard Event Pak - Incidents
; Query Definitions

Events
Repoart Defintions
Srhadilad Panart

12. Go back to Standard Event Pak Incidents.

13. Click Query Definitions.

14. Find the name of the query noted above. In this example, it is Incident — Incident Class ‘X'.
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15.

16.

17.

18.

19.

20.

File Edit View Help

5 New Query Definition | &} Print | < Delete

Events

i Event Management Falders
El @ #pplication Events D escription Unique

B .J Company Mame * Incident - Access Level % Incident D
@ OQuery Defiritions * Incident - Blank Outcome with Status Cloged Incidentl D
Everts * Incident - Business Unit Level 1 of %' Incidentl D
Repart Definitions * Incidert - Business Unit Level 1 of ', Level 2" Incident D
Scheduled Reports * Incidert - Business Unit Level 1 of ', Level 27", Level 32 Incident D

fg Basic Scripts * Incident - Business Unit Level 1 of "', Level 2", Level 3 2, Level | IncidentD
Standard Event Pak - Activities =

| Standard Event Pak - Admin * Incident - Class "', Category " Inc:ldentID
| Standard Event Pak - Assignments - Genel * |ncident - Class "', Category ", Subcategary 2 Incident! D
| Standard Event Pak - Cases * Incident - Closed Incidents IncidentlD
| Standard Event Pak - elncidents *Incident - Closed Incidents - No E xpiry Incident! D

| Standard Event Pak - Incidents * Incident - Closed Last Manth IncidentMum
ﬂ Query Definitions * |ncident - Created in the Last ‘' Days Incident! D
Events * Incident - Created Last Manth Incident! D
Report Definitions * |ncidert - Created ¥TD Incidert D
Scheduled Reparts * |ncident - Disposition %' Incident! D
"}.; Basic Scripts * |ncident - Due in %' Days Incidentl D
-8 Standard Event Pak - ltems # Inrident - Flan af ' InridsnH T

Highlight the Incident — New Incident and type CTRL + C.
Go to the new application and click Query Definitions.
Make the Description window active by clicking inside of it.

Type CTRL + V to move the Query.

| File Edit View Help

JJ‘i:L New Query Definition | Zh print | ¥ Delete

5 Event M anagement Folders
- El"@ Application Events Description Unique
=] Company Name

3l Query Definitions

Events

Feport D efinitions
Scheduled Reports

1’&5 Blasic Scripts

Standard Event Pak - Activitiez
Standard Event Pak. - Admin

-
-
£ .J Standard Event Pak - Assignments - Gener
-G
-G

h

* |ncident - Class "' IncidentD

Standard Event Pak - Cazes
Standard Event Pak - elncidents

| Piadeid P Pl L aid e

R I s W e O ]

Go back to the new application events.

Double-click the Incident — Single — Incident Class ‘X'.
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&4 Perspective Workflow - Application Events\Company Name\Events “
File Edit Help

& save and Close | i Save and New | ¥ Delete | o Previous ~ W Next -

Event Description:  Incident - Single - Class of %'

D escription |Queries| Heportsl Filesl Eopyl Emaill FaHl F‘agel WebEastl IMl Actionsl Subscribersl Schedulel Track

Internal ID nurmber: |3254
Event Description: |Incident - Single - Class of %'

Lookup Key [Optional); |

Fricrity [O=Highest): |5 o l
v §

|~ Repeat natification for tiggered iems.

¥ Keep only last checked record in Monitar.

Hiztomn:
Item created by: [ GKETEL:Heidi Suteau
Item created o [2014-06-30 11:24:31 AM
Item last changed byt GKETEL1:Heidi Suteau
Item lact changed on: (201 4-06-30 11:24:31 AM
Maotes:

<< Back | Mest s» | Cancel Help

21. Inthe Description tab, check the Active box.

22. Click the Query’s tab. Note: Where Application still has Standard Event Pak.

43




Perspective Workflow Installation Guide

File Edit Help

[ save and Close g Save and New | W Delete | 4 Previous ~ W Next +

Event Descrption:  Incident - Single - Class of %'

Description Heportsl Filesl Copyl Emaill Faxl F'agel WebCastl IM| Actionsl Subscribersl Schedulel Track

Queries Selected For Content
Application Query Description

Add Cueny.... | Standard Event Pak - | Incident - Clags %'

I~ Use Script instead of Query Script: I Select Script... |
<-Remove Query | <<-Remaove All Queries |

Event Trigger Parameters
Question Angwer
what Clazz value would vou like ta filker by?
How far back would you like to search?

23. Click the Remove All Queries button.

24. Click New Query.

Application: Company Mame

Select Another Application

Quenes Awailable For This Application

Query Descriphion

Incident - Clazs '«

4] | 2
Select | Mew Queny... | Cancel |

25. Select Incident — New Incident Query.
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26. Click Select. Note: The application changes.

& Perspective Workflow - Application Events\Company Mame\Events H
File Edit Help

[ save and Close | {ad Save and New | ¥ Delete | 4 Previous ~ W Next ~

Event Description:  Incident - Single - Class of &'

Description  Queries IHeportsl F\Iesl Eopyl EmaiII Fax' F'agel WebEastI IMI Actionsl Subscribers Schedulel Track

Gueries Selected For Content
|Appllcat|0n I Guery Description I
Add Quer. | B | Company Mame [ Incident - Clags ' |

[~ Use Script instead of Query Script: I Select Scrpt... |
<-Aemave Query | <<-Remove All Queries

Ewvent Trigger Parameters
Question Answer
‘what Class value would you like ta filker by?
Haw far back would yau like to zearch?

v

<¢ Back | Mest > | Cancel | Help |

27. Ifthereis an ‘X' in the name, you can enter a parameter in the Event Trigger Parameters
field by clicking the ellipsis and selecting a value, or entering it directly in the text field.

Note: Only values that have been saved in at least one record in your database will be
available for selection using the Browse (...) button. If you wish to specify a filter value that
is not available, you must type it in the Answer field.

55 Perspective Workflow - Please supply avalue - DO

WWhat Clazz value would pou like to filker by?

I =

Available Substitution Y ariables:

ZCurrent Date MDD YE ~
ZCurrent D ate Time

ZCurrent D ate v MM AODE

ECurrent D ate v MDD

ECurrent D ate ¥ -MM-DD3

ECurrent DateX

ZCument Dap hd

kK I Select This Item to compare | Cancel |
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File Edit Help

[ save and Close g Save and New | W Delete | 4 Previous ~ W Next +

Event Descrption:  Incident - Single - Class of %'

Description  Queries |Hep0rts| Filesl Copyl Emaill Faxl F'agel WebCastl IM| Actionsl Subscribersl Schedulel Track

Queries Selected For Content
Application Query Description

Add Cueny.... | Standard Event Pak - | Incident - Clags %'

I~ Use Script instead of Query Script: I Select Script... |
<-Remove Query | <<-Remaove All Queries |

Event Trigger Parameters
Question Angwer
what Clazz value would vou like ta filker by? Criminal
How far back would you like to search?
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28. Select the Email tab, and choose an option for the Email Account to Send From field.
(This indicates the account that all email alert messages for this event will be sent from.)

& Perspective Workflow - Application Events\Company Name\Events “
File Edit Help
n Save and Close g Save and New }( Delete | 4 Previous ~ W Mext ~

Ewvent Description: Incident - Single - Class of ‘%'

Description] Queries] Heports] Files] Copy  Email lFaH] Page] Webl:ast] IM] Actions] Subscribers] Schedule] Track]
Available values for uze in meszage content:

1B uilding} N

{Categary}

{Class} |
{CreatedByl zer}

{CreatedDate} v

Email Account to Send From: | SEEETEENEE

Lol Lol

Email Reply Address (0 ptional): |

Mezzage Subject:

{IncidentMNumber} with Class {Class}

Mezzage Tent:
{BECIN*HTML} ~
<table>

<tr¥

<td style="vertical-align:top;width:200px;">Incident Number<br />
{IncidentNumber}</td>

<td style="vertical-align:top;width:200px; ">Reported Date/Time<br />

v Include reports as email attachments. v Include files as email attachments.

Iv Email notificatiohs should wait until reports are completed.

<4 Back | MHext »» | Cancel Help |

29. Feel free to edit the message subject, but do not edit text enclosed in curly brackets, such
as {AccessLevel}. This text will be automatically replaced by data drawn from the specific
record(s) triggering the event.

Note: If you have someone who knows HTML, have someone edit the Message Text but do
not alter the curly brackets.

30. Select the Subscribers tab, and then select the Standard sub-tab.
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File Edit Help

[ save and Close g Save and New | ¥ Delete | 4 Previous ~ W Next =

Event Description:  Incident - Single - Class of "'

Descriptionl Queriesl Fleportsl Filesl Eop_l,ll Emaill Faxl Pagel WebEastl IMl Actior

Add Subscriber... |

Standard | Advancedl

| Schedulel Track

Usgers Targeted For Delivery

ISuhscriber IType I Email I Fax I Copy I Page IWebCast I 15|

Computers Targeted Far Delivery

I Subscriber

| Type

|
<-Remove Subscriber |

<<-Remove All Subscribers |

<< Back MHewt »»

Cancel

31. Click Add Subscriber.

Flace a checkmark nest to the subscriber ar group to notify

Subscibers
|:| Eomﬁulers

=[] Users

[] Management

[] Perspective Users

Add Subscriber

Cancel
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32. Select the users who will be receiving this e-mail.

33. Click Add Subscriber.

49

& Perspective Workflow - Application Events\Company Name\Events ﬂ

File Edit Help

[ save and close i Save and New | W Delste | 4 Previous ~ W Next -

Ewvent Diescription:  Incident - Single - Class of '’

Descriptionl Queriesl Heportsl Filesl Eopyl Emaill FaHl F'agel WehCastl IMI Actions  Subscribers |Schedule| Track

Standard |Advanced|
Add Subscrber... |
Users Targeted For Delivery
Subscriber Type Email Fax Copy | Page | ‘WebCast | IM
P Frushchyzhon, Dale Lzer v | |l |l | |l
Computers T argeted For Deliverny
I Subscriber I Type I Copy I 14
L | 2
<-Remove Subscriber | <<-Remove &ll Subscribers |
<< Back | Mewt »» | Cancel | Help |
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34. Select the Schedule tab.
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=4 Perspective Workflow - Application Events\Company Name\Events

File Edit Help

[ save and Close | i Save and New | ¥ Delete | 4 Previous ~ 4 MNext -

Event Description: Incident - Single - Clags of '

Descriptionl Queriesl Heportsl Filesl Copyl Emaill Faxl F‘agel WebCastI IMI Actionsl Subscribers Schedule |Trac:k

Choose a schedule to use:

Edit This Schedule...

=

| Create Mew Schedule... |

— Scheduling Information:

Frequency:Every n Minutes, Minutes B0
Allowed Days: Mondap Tuesday Wednesday Thursday Friday

Allowed Months:)anuary February March April May June July August September October Mavember December
v

v Shaould thiz run on a haliday

Add Dependency... |

The curment event will be tiggered if the following event(s) are triggered:

I Application I Evwent Description

<-Remaove Dependency |

<<-Remaove All Dependencies |

<< Back Mest »» |

Cancel |

Help
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a.

Select an option for the Choose a schedule to use field (e.g., Every Hour, Every
Monday at 9:00 AM, etc.).

if Perspective Workflow - Application Events\Standard Event Pak - C 3 ﬂ
File Edit Help

[E save and Close | Save and New | > Delete | 4 Previous - ¥ Next -

Ewvent Dezcription: Case - Access Level of '

Descriptinnl E!ueries' Flepu:urtsl Filesl Enp_l,ll Emaill Fa:-:l F'agel 'W'el:uEast' IMl .ﬁ.ctiunsl Subscribers  Schedule |Trac:k

Chooze a schedule to uze: |[SEEIEIl oii=r ;I
Edit This Schede.. | Create New Scheduls.. |

Scheduling |nformation:
Frequency:Every n Minutes, Minutes 5 -

Alloved Days: Sunday Monday Tuesday Wednesday Thursday Friday Saturday
Aillowed b onths:)anuan Februar M arch Apil M ay June July August September October Movermber December

[
[ Should this run on a haliday
Add Dependency. .
The curernt event will be tiggered if the following event(z) are tiggered:
I Application I Eent Description I

<-Remove Dependency | <¢-Remove All Dependencies |

<< Back Mewt > | Cancel | Help

OR

Click the Create New Schedule button.

In the Schedule field, enter a description for your new schedule.
In the Should not run until after date/time field, enter a future date when events
using this schedule will begin to run, or leave the field blank if you want the

schedule to be activated immediately.

In the Frequency field, choose an option for the schedule’s rate of recurrence (e.g.,
Every n Minutes, Daily, Weekly, etc.); then, in the new field that appears below,
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53

specify additional details for the frequency, such as the time of day for the event to
run or the day of the week.

File Edit Help

[ save and Close | ¥ Delete | 4 Previous v W Next ~

Schedule: The 1zt of Every Month at 00:01

Descrnption T Allowed Range T Histary ]

Internal 1D number: IdD

Schedule: |The 1zt of Every Marth at 00:01

Shauld nat run until after datestime: |

— Frequency Information:

Frequency: |Monthly
Day Of The Manth |1

D aily time ta run IDD; m|
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iv. Under the Allowed Range tab, specify the months of the year, days of the week
and hours of the day that the event is eligible to run. (Times are inclusive.)

Perspective Workflow - H

File | Edit Help

[& save and Close | ¥ Delete | < Previous - # Hext -

Schedule: The gt of Every Month at 00:01

Description | Allowed Range T Histary ]

— Schedule will un on the following months:

W January W Mayp ¥ September
¥ February ¥ June ¥ Dctober

[V March W July ¥ Movember
W Apil W August ¥ December

— Schedule will un an the following days:

v Sunday v ‘wWednesday
¥ Monday ¥ Thursday
W Tuesday ¥ Friday

D aily range begin time: I‘I2:DD:DD AM Daily range end time: |1‘I:59:DD Prd

v. Click Save and Close.
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35. Click Save and Close. The event is now activated and will run according to the specified
schedule alerting the subscribers indicated.

& Perspective Workflow - Application Events\Company Name\Events “
File Edit Help
E Save and Cloze g Save and New }( Delete | 4w Previous = W Next -

Ewvent Description;  [ncident - Single - Clags of %'

Description] Bueriesl Heports] Filesl Eop_l,ll Email] Fa:-:] Page] WebEast] IM] .-’-\c:tions] Subscribers  Schedule lTrack

Choose a schedule to use: | The Tst of Every Month at 00:01 =]

Edit This Schedule... | | Eratia Mo Sohaduis. |

Scheduling Information:

Frequencsy:bonthly, Day OF The Month 1 Draily tirme booon 00:01 ~
Allowed Daps:Sunday Monday Tuesday Wednesday Thursday Friday S aturday
Allowed Months:) anuary February March April WMay June July August September October November December

v Should this run on a haliday

Add Dependency...

The current event will be triggered if the following event(z] are tniggered:
Application Event Description
<-Hemove Dependency | <¢-Remaove All Dependencies |
<¢ Back Mest »» | Cancel ‘ Help

36. Continue to apply these steps to all events you would like to activate.

Note: Please make sure you close any Workflow modules at the end of the day so that Workflow
can do its nightly scheduled maintenance.
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Contact Information

Technical Support

Toll Free: 1-877-776-2995

Phone: (780) 448-0616

Email: support@ppm?2000.com

PPM 2000

Toll Free: 1-888-PPM-9PPM (1-888-776-9776)
Phone: (780) 448-0616

Fax: (780) 448-0618

Email: information@ppm2000.com
Website: www.ppm2000.com
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